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Past meeting information
August 16, 2008
Peter Berghammer

In a presentation at the Black Hat 
brieýngs, Mark Dowd of IBM 
Internet Security Systems (ISS) and 
Alexander Sotirov, of VMware Inc. 
discussed the new methods they’ve 
found to get around Vista protec-
tions such as Address Space Layout 
Randomization(ASLR), Data Ex-
ecution Prevention (DEP)  and oth-
ers by using Java, ActiveX controls 
and .NET objects to load arbitrary 
content into Web browsers.
“What this means is that almost 
any vulnerability in the browser 
is trivially exploitable,” Dai Zovi 
added. “A lot of exploit defenses 
are rendered useless by brows-
ers. ASLR and hardware DEP are 
completely useless against these 
attacks.”
Peter Berghammer returned from 
DEFCON the sister conference of 
Black Hat. He  is familiar with the 
above announcement. He talked 
about this and some other exploits.

September 20
AMD

They gave a great 
talk about their 
processors and 
extremely fast ATI 
video cards. The 
comparisons were 
very informative.
You can ýnd 
comparison charts 
of AMD and Intel 
CPU processors at 
CPU Benchmark or         
Tom’s Hardware

October 18 
Intel
The rep covered Mobile processors 
Centrino 2, quad core, and the new 
i7.

Next month November 20 
Peter Berghammer - and WAR
Open Source warfare. This is the 
application of open source tech-
niques and information sharing 
by military groups, especially 
insurgents, over the last few years. 
Think of the evolution of IEDs in 
Iraq and how various decentral-
ized groups pass information and 
technology (or techniques) to each 
other around the world.
 
You can download video of the 
meetings from the WINNER web-
site www.windowsusers.org/meet-
ings.html 

October 2008
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possibility the RAMBUS RAM 
may be conþicting. Lo and behold 
that was it and the computer was 
working pretty good for simple 
things. Lately though it will just 
reboot for no reason and upon 
coming up it says Windows could 
not ýnished loading because it was 
missing a hal.dll. It is there, but 
Windows could not ýnd it on the 
reboot. After a couple of months 
of this I reluctantly decided to 
reinstall Windows XP on it. I put 
in the XP installed disc, formatted 
the drive and did the reinstall. 
Even did the Windows updates. 
Then I started to notice something 
about the drive, it was the wrong 
size. I have two hard drives in 
the computer and Windows had 
installed itself onto the second 
drive instead of the master drive. 
Debating whether to reinstall or 
just switch jumper pins. 
My HP notebook about 5 months 
ago all of a sudden said my 
Window  proýle could not be 
found. Something got corrupted. 
My Documents folder and things 
normally stored there were gone. 
According to research I did I 
should have been able to get the 
ýles back by doing a search for 
them. They could not be found. 
Luckily it was my notebook and 
I really did not have much to lose 
there. I just had to recreate a user 
account. 
Which brings me to my Toshiba 
Notebook. Last month and got a 
message saying the Vista operating 
system was corrupt and I had to 
reinstall. So I had to do a restore 
from the disc which formats wiping 
out everything and reinstalls 
Windows. Which I then had to 
reinstall everything else. Again not 
much data lost on it though.
Which brings me to say 
“Computers are so much fun.”

Computers are so much 
fun
By Terry Currier

You probably noticed there has not 
been a newsletter for three months. 
I have three desktop computers 
and two notebooks. Lets face 
reality, the more you have, the 
more chances for something to go 
wrong. About seven months ago 
my eMachine computer stopped 
working. It just would not power 
up. I still feel it was my grandson 
who caused it. He liked that the 
logo would light up when turned 
on, and of course go away when 
turned off. He therefore liked to 
turn it off and on. I considered my 
test computer, trying  not to load 
too many things onto my main 
computer. So I replaced it with 
another computer.  
In that new computer I put my 
HD ADS TV card. It was working 
ýne with the TV antenna, but I 
just could not leave it alone and 
tried to hook the cable through it. 
Technically it should have worked, 
but of course it did not. In fact the 
attempted changes messed up the 
system. Not a lot but enough to 
where I ýgured I would just do a 
restore. Which of course did not 
ýx it. This computer has Vista 
Business on it and I just did a 
complete backup two days earlier. 
So I tried to do a complete restore 
from the backup. Again this is not 
set up to be a real fast computer, 
rather a secondary. But, I really 
feel that it going onto a third day of 
trying to do a complete restore was 
enough. I ended up taking the TV 
card out and working it back. 
My oldest computer is a 1.7Ghz 
Pentium 4 would lock up too many 
times, and I was going to scrap it. 
Then Steve Dela mentioned the 



VIPRE 
Antivirus and Antispyware program from Sunbelt
By Terry Currier 

The computer software world is saturated with 
antivirus software. If a company wants to bring out 
another it had better be good. Sunbelt Software makes 
Counterspy, one of the top rated antispyware software. 
They decide they wanted to get into the antivirus 
market, but instead of buying another company as 
some have done, they wrote their own from the ground 
up. VIPRE stands for Virus Intrusion Protection 
Remediation Engine. I can not really test for viruses 
(and darn sure don’t want to.) The experts at PC 
Magazine did test it and gave it 4 stars out of 5 - http://
www.pcmag.com/article2/0,2817,2326526,00.asp. 
Installation was very easy. A wizard asks some 
questions and helps set it up. A nice touch in the end, 
it takes you to a þash video of how to use the program. 
The interface is easy to use and understand. The 
Overview tab gives you: 

Scan Status – last scan and next¶ 
Active Protection - settings ¶ 
Email Protection - support for Outlook, ¶ 
Outlook Express and Windows Mail; and 
support for any email program that uses POP3 
and SMTP
Update – set up for how often you want it to ¶ 
check
Subscription – how many days are left on your ¶ 
subscription 

The Manage tab gives you:
History - of scans¶ 
Quarantine ï and ýles VIPRE deemed unsafe ¶ 
and put there to protect the computer

Always Blocked – you can view risk that ¶ 
are blocked by the Active Protection and 
Quarantine
Always Allowed – even though there is no ¶ 
Firewire VIPRE monitors ýle activity and 
will present to you something that may be 
suspicious. You can choose to block or allow 
at the time of the popup, or set it up to always 
allow
Schedule Scans – set up when you want it to ¶ 
scan and how deep

You can schedule VIPRE for either full or deep scans 
for at a speciýed time on speciýed days of the week. It 
will also do scans on demand.
Under the Tools tab there are three useful programs:

A history cleaner¶ 
A secure ýle eraser¶ 
PC Explorer - reveals processes and services ¶ 
running that might be suspect or known to be 
malicious. 

http://www.pcmag.com/article2/0,2817,2326526,00.asp
http://www.pcmag.com/article2/0,2817,2326526,00.asp


As stated before VIPRE was written from the ground 
up. So the programmers made very good use of 
the computer memory. It uses only about 31K of 
memory at startup. Testing was done on my two 
older computers. One clone, a Pentium 1.7GHz with 
512MB RAM, the second was my HP notebook. It 
has a Celron 1.3GHz with 768MB of RAM. With the 
notebook using AVG Free version 8 antivirus and 
antispyware it took 3 hours, 10 minutes to do the scan. 
With VIPRE it took 1 hour, 5 minutes. That was so 
fast I had to look to verify it was actually set for doing 
a deep scan.

 

The only weakness I could ýnd was with the 
downloading of updates. By default it’s set up to check 
for updated deýnitions every two hours (you can 
change that). If you did not turn on the computer for 
a number of days the threat deýnition would be out of 
date and it would warn you of this fact. VIPRE waited 
for the time period to end before checking for updates. 
It really should get the updates right away if it knows 
they are out of date. I pointed this out to them, and 
they agreed and said that will be ýxed very soon. They 
also told me their excellent ýrewall will be in the next 
version of VIPRE.
All annual subscriptions include one year of threat 
deýnition updates, software upgrades, and US-based 
toll-free technical support. Pricing: 

If you still use Sunbelt’s CounterSpy it is ¶ 
available as an upgrade for $9.95
A single user annual subscription is $29.95, ¶ 
two computers for $34.96, three for $39.90   
For four or more an annual subscription price ¶ 
of $49.95, will cover all the PCs in your house 
with a single site license. 

http://www.sunbeltsoftware.com/home-home-ofýce/
vipre/ 
You can get download a full working trial version at 
the above link. If you have an old computer VIPRE is 
something you should deýnitely look at. Even newer 
computers though will beneýt from itôs memory 
management. 

Something to note
On one of my computers I’m using the Trend Micro 
2007 antivirus and antispyware program, along with 
Spybot. I notice that there were many times the hard 
drive light was þashing when it should not be needed. 
Bringing up Task Manager I notice a ýle - PcScnSrv.
exe was using 150Kb of RAM. Searching I found out 
this is a ýle used by Trend Micro, but more important 
it mentioned that it, and Spybot Immunize do not play 
well together. I followed the instructions from the 
Trend Micro website and now it is working smoother 
and the PcScnSrv.exe is only using 42Kb. 

End of Article  -  End of Article  -  End of Article  -  End of Article    End of Article  -  End of Article

http://www.sunbeltsoftware.com/home-home-office/vipre/
http://www.sunbeltsoftware.com/home-home-office/vipre/


 The Crabby Ofýce 
Lady 
 

Crabby’s guide to 
Ofýce downloads
 
 
Get the Crabby Ofýce Ladyôs book 
Read all the Crabby Ofýce Lady columns 
Get Crabby’s columns via RSS 
View Crabby’s videos 

Think of a trip to the Microsoft Ofýce Downloads 
Web site like a trip to the bank, the grocery store, 
or even the cosmetic surgeon: Sometimes you just 
need to boost your power, stock up on necessities, 
or perhaps add a little þuff and well-being to your 
computing lifestyle. Ofýce offers a variety of 
downloads designed to give you all of that and much, 
much more.
And hereôs the difference between a trip to Ofýce 
Downloads and a trip to, say, the plastic surgeon: All 
of our downloads are free. That’s right: F-R-E-E. As 
in complimentary, gratis, cuffo. But on the other hand, 
as I view it, there are two parallels between plastic 
surgeries and Ofýce downloads:
Certain cosmetic procedures (Botox injections, 
liposuctions, and chemical peels) and certain Ofýce 
downloads (PowerPoint Viewer 2003, Ofýce Sounds, 
and Outlook PST Backup) tend to be more popular 
than the other offerings among the general population. 
Conversely, certain cosmetic procedures (such as 
buttocks implants) and certain Ofýce downloads 
(such as the Microsoft Visual Keyboard add-in, 
where you can type in more than one language on 
the same computer) are often overlooked, hidden 
gems — things that you should perhaps explore more 
fully before passing judgment. 

Deýne the terms
If you’re a regular Crabby reader, you know that I 
sometimes like to deýne some terms before jumping 
into the topic at hand. That way I know we’re all on 
the same page. Rather than blanket all of you with that 
dry information, I’ve stuck it on a different page that 
you can refer to at your leisure: Downloads: Deýning 
the terms.

The how, when, and where of downloads and 
installations
Now that we have some of the major terms ýgured 
out, when it comes to how to ýnd, when to ýnd, and 
where to ýnd Ofýce downloads, Iôm here to tell you 
that there is more than one way to skin a cat. However, 
being the animal lover that I am, I won’t be sharing 
that information with you today (even if I knew the 
ways myself — which I don’t). I can, however, give 
you some advice — or at least ideas — about the how, 
when, and where of Ofýce downloads.

The best way to keep up with the Gateses
If you want to keep up with the latest and greatest (not 
to mention safer and more secure) downloads for any 
version of Ofýce, the best thing to do is use Ofýce 
Updates.
If you don’t know if you’re up-to-date, you can check 
a couple of ways:
In any Ofýce program, on the Help menu, click 
Check for Updates. This will take you to the Ofýce 
Downloads site, where you’ll click the cute little 
button that says Check for Updates. This will scan 
your computer (and won’t send any personally 
identiýable information to us, by the way), and let 
you know what you’re missing. You can decide if you 
want to download the list it comes up with or not. 
 NoTE   While you’re there, you can check to see 
what you’ve already installed by clicking Show 
already installed Ofýce updates in the left navigation 
pane.
Go directly to Microsoft Ofýce Downloads, and again, 
click that cute Check for Updates link (it’s in the top 
left corner with a friendly green arrow in front of it). 
Order a service pack CD. Service packs tend to 
be fairly large and if you’re using a 56Kb modem, 
chances are you have neither the time nor the 
inclination to download one. Thankfully, you can 
order a CD and have the service pack sent to you. 
Don’t forget, though, that the postal person will need 
a few days to get that CD to your house. Order Ofýce 
Service Packs on CD-ROM 

When you just gotta have it
If you feel you must have the video e-mail add-in for 
Outlook 2003 because you jealously noticed that your 
ofýce-mate has it and you donôt (known as ñadd-in 
envyò), you can just march right on over to the Ofýce 
Downloads site and go get it! 

http://office.microsoft.com/search/redir.aspx?AssetID=XT101105961033&CTT=5&Origin=HA011872211033
http://office.microsoft.com/search/redir.aspx?AssetID=FX101679371033&CTT=5&Origin=HA011872211033
http://office.microsoft.com/search/redir.aspx?AssetID=XT012249501033&CTT=5&Origin=HA011872211033
http://office.microsoft.com/search/redir.aspx?AssetID=FX101727101033&CTT=5&Origin=HA011872211033
http://office.microsoft.com/search/redir.aspx?AssetID=ES790020041033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=DC010505971033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=DC010554461033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=DC010801081033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=DC010554541033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=HA011862991033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=HA011862991033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=ES790020041033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=FX010383631033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=FX010383631033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=DC010972691033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=DC010972691033&CTT=5&Origin=HA011656431033


Add-ins are an example of a type of download that 
you can decide if you want to download or not; they 
tend to be either yummy nuggets of enhanced features 
designed to make your life more fun (such as the 
Ofýce Sounds add-in) or special enhancements to a 
program (such as OneNote 2003 SP1 Add-in: Send to 
OneNote from Outlook PowerToy, which gives you 
the ability to send e-mail messages to a OneNote page 
from Outlook 2003 with the click of a Toolbar button). 
They’re usually not required to make your program 
go; they’re more for pleasure.

Letôs go international
While most of my columns don’t get translated into 
all the other languages that have an Ofýce Online 
site (some things just don’t translate well, as you 
can imagine), the fact is, more people use the U.S. 
versions of the products themselves than any other 
language even though there are more non-English 
customers than English-speaking customers. (Read 
that again to make sure you got it.)
Multilingual User Interface Packs (or MUIs), as well 
as Language Interface Packs (or LIPs), allow the 
international user interface (or “UI”) to be applied to 
the English version of the international versions of 
Ofýce products. This makes it easy for those folks 
who have the English version of Ofýce to still be able 
to have some of the UI in their native language. It’s 
like having the best of both worlds.
So, if you want to test this out on your Icelandic 
version of Word (or any other Ofýce product for 
several other languages), visit these links:
Multilingual User Interface Packs (MUI) downloads 
Language Interface Pack (LIP) downloads 
Now, some languages donôt have an Ofýce 
Downloads Web site (sad, but true), so we offer 
them More international downloads. This page offers 
downloads for many languages, including Farsi, Irish, 
Macedonian (FYROM), and Vietnamese.
 NoTE   For more information about using Microsoft 
products in languages other than English, visit the 
Microsoft Local Language Program Web site.

Why so many? Why so often?
And ýnally, the ultimate question: Why do we have 
so many updates so often? In a word or two: We’re 
human, and we do make mistakes. But more than 
that, technology moves so fast that while we’re busily 
ýxing the issues that crop up after we make a product 
available, we’re also coming up with newer and better 

ways of doing things. And frankly, we get many of our 
ideas for new features from you, the loyal customers. 
So why should we let a good thing get away? 
 NoTE   And how can you make a feature request? If 
itôs about the Ofýce Online Web site, you can Provide 
suggestions and feedback to Microsoft. If it’s about 
an Ofýce product, you can Suggest changes to Ofýce 
products.
If we waited until every download was perfect before 
making it available to you, all of our fun and useful 
downloads would be few and far between. You’d be 
waiting and waiting and waiting. 
And so, while we want to be competitive, we need to 
balance how long it takes to create the software and 
how perfect it is. We want to give you what you want 
since you’re so darn demanding, but sometimes things 
don’t go exactly as planned <gasp>, and we need you 
to install a patch (I mean an update). So if we ask you 
to do it, please do. It’s for your own good, dearie; 
we’re not just trying to drive you crazy.
ñI have not failed. Iôve just found 10,000 ways that 
wonôt work.ò ð Thomas Edison

5 time-saving Word tips from 
Crabby’s readers
When I went in search of some great Word tips, ones 
that I hadn’t highlighted before, the best ones I came 
up with were those submitted to me by you, my loyal 
readers. And so this week’s column is written entirely 
by you. What a community we’re turning into!

Tip #1: Copy a group of Excel cells into a Word 
document and make it look goooood
From J.C. in Kansas: 
Select your cells in Excel. 
Copy (Ctrl+ C). 
In your Word document, on the Edit menu, click 
Paste Special. 
Click Microsoft Ofýce Excel Worksheet Object, and 
then click OK. 
See? These two programs really can play nice 
together.

Tip #2: Keep important lines together
We all know, in our heart of hearts, that it’s not cool, 
correct, or even pretty to separate headings from the 
lines that follow, or split up bulleted or numbered lists. 
So how do you solve this when you’re using page 

http://office.microsoft.com/search/redir.aspx?AssetID=DC010554461033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=DC011409121033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=DC011409121033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/en-us/results.aspx?Scope=DC&Query=mui&Origin=HA011656431033&CTT=5
http://office.microsoft.com/search/redir.aspx?AssetID=HA011133501033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=HA010382851033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=XT011621481033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=ES010034521033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=ES010034521033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=XT011460121033&CTT=5&Origin=HA011656431033
http://office.microsoft.com/search/redir.aspx?AssetID=XT011460121033&CTT=5&Origin=HA011656431033


breaks? C.G. of Michigan found the solution:
Select the paragraph(s) you want to keep together. (For 
just a single paragraph, you don’t need to highlight the 
whole thing; just place the cursor anywhere within it.) 
On the Format menu click Paragraph. 
Click the Line and Page Breaks tab, and then select 
Keep lines together. 
There are so many handy little options on the Format 
menu; why don’t you take a little day trip into that vast 
space and let me know what you ýnd?

Tip #3: Add a break from within a list
Sometimes you want to add a note or a break from 
within list items, kind of like this:
Here is the ýrst item 
 
And here is the break. 
And here is the second item. 
Rather than turning off the list and messing around 
with the margins, J.B. of Wisconsin wrote with the 
quick and easy solution: Shift + Enter. That will 
maintain the margins, move the cursor on to the next 
line, and not generate a new bullet or number. How 
sweet it is.

Tip #4: A beautiful layout is a beautiful thing
Two people wrote to me about the same thing on 
the same day: formatting. Business owner J.B. of 
California and high school business teacher P.P. of 
New York offered the same tip when you want to 
ýgure out why your document isnôt looking so great: 
Click Show/Hide  on the Standard toolbar to 
reveal all of the hidden formatting marks, 
and then make whatever changes are necessary. 
Now you have no excuse for messy formatting.

Tip #5: Create a new ýle lickety-split
S.S. of California wrote to me with a fantastic tip, 
a shortcut really, for creating a new Word doc (or 
PowerPoint presentation, Excel workbook, or any 
other Ofýce ýle): Instead of creating a new ýle by 
going to Start > Application > File Menu > New, 
create a shortcut on your desktop that will do all this 
for you:
Right-click anywhere on your desktop, point to New, 
and then click the type of Ofýce document you want 
to use as a shortcut.  
 
Now, whenever you need to start a new document, 
spreadsheet, or whatever, two clicks is all it takes. 

Thanks for all your great tips, folks. I’ve been getting 
so many that I don’t even have to think up new ones 
myself. Talk about the lazy days of summer... .
ñAnything that is of value in life only multiplies 
when it is given.ò ð Deepak Chopra

5 time-saving Excel tips from 
Crabby’s readers
Here are some of the best Excel tips you’ve sent to 
me during the past few months. You all are like Excel 
Obi-Wan Kenobis, I tell you....

Tip #1: It’s a wrap!
This tip will solve what I gather to be a BIG issue with 
some of you:
S.S.H. in the British Virgin Islands wrote to make 
wrapping easier: Press Alt+ Enter and abracadabra, 
your cursor moves to the next line within the cell. 
Instant wrapping. Read more about formatting and 
editing cells:
Use Format Painter to copy cell formats to other cells 
Turn the option to edit directly in cells on or off 
Display cell contents in a shape or text box 

Tip #2: What day is today? Excel knows
From S.S. in California: Press Ctrl+ ; to enter the 
current date in a cell. No thinking, no referring to the 
calendar or your oft-erroneous watch. Excel knows all.
Here are some more ways Excel can automate your 
spreadsheet life: 
Automatically number rows 
Automatically save a backup copy of a workbook 
Add or remove data marker labels in a chart 
Turn automatic completion of cell entries on or off 

Tip #3: Move this way or that way
Next up is a tip that involves one of my favorite things 
about Ofýce in general: customizing it to suit your 
needs. M.K. of Ontario, Canada, writes:
“In Excel, when you press enter, you are automatically 
moved down a cell. This is sometimes a pain when 
you are entering data and it would be better to just go 
across the line. You can change this default by clicking 
Tools on the menu bar and then clicking Options. 
Choose the Edit tab. Look for the Move Selection 
after Enter box. In the drop-down, you can choose 
the direction you want the selection to move to. Also, 
if you want to move in the opposite direction, hold the 
Shift key and press Enter.”

http://office.microsoft.com/search/redir.aspx?AssetID=HP051994341033&CTT=5&Origin=HA012110041033
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http://office.microsoft.com/search/redir.aspx?AssetID=HP051984711033&CTT=5&Origin=HA012110041033
http://office.microsoft.com/search/redir.aspx?AssetID=HP052035811033&CTT=5&Origin=HA012110041033


 
__________________
About the author
Annik Stahl, the Crabby Ofýce Lady columnist, takes 
all of your complaints, compliments, and knee-jerk 
reactions to heart. Therefore, she graciously asks that 
you let her know whether this column was useful to 
you — or not — by entering your feedback using 
the Was this information helpful? tool below. And 
remember: If you don’t vote, you can’t complain. 
Comments
________________________________________

The road less traveled, the road most trodden; now 
everyone can go his or her own way. Read more about 
ways to customize Excel:
Create your own worksheet functions 
Change the color palette in a workbook 
Customize how Excel starts 

Tip #4: Have shortcut, will make charts
This next tip is short, sweet, useful, and apparently 
underdocmented. J.N. from Minnesota writes: 
“I am amazed how few people teach, know about, 
and use, the F11 key in Excel to create charts. It is the 
easiest way to create a simple chart. Then use the chart 
toolbar and the ‘double-click to change’ method to 
customize it from there.” 
Once again, amazement turns into teaching here at the 
Crabby tip round-up.... Read more about charts.

Tip #5: Convert “numbers stores as text” to...numbers!
G.E. from Texas apparently became the darling of 
her ofýce when she ýgured out a way to deal with that 
nasty green triangle that shows up in the corner of a 
cell that won’t let you change the formatting. (A green 
triangle in the upper-left corner of a cell indicates an 
error in the formula in the cell.) Her colleague needed 
to do some formatting but each cell that had that green 
triangle wouldn’t budge. So G.E. found the solution:
Select a blank cell that you know has the General 
number format. 
In an empty cell, type the number 1 and press ENTER. 
Select the cell, and on the Edit menu, click Copy. 
Select the range of “numbers stored as text” that you 
want to convert. 
On the Edit menu, click Paste Special. 
Under Operation, click Multiply, and then click OK. 
Delete the content of the cell entered in step 2. 
Now, while this tip is, yes, already presented as a Help 
topic both in Excel and on Ofýce Online, I thought it 
deserved to win a Tip of the Week prize since it’s kind 
of complicated and most people probably wouldn’t 
know what to ask when heading off to ýnd a solution 
to the problem.
Read more about triangle indicators in cells.

ñComputers are useless. They can only give you 
answers.ò ð Pablo Picasso

Acronis True Image Home 2009
By Gene Barlow
User Group Relations
Copyrighted October 2008
Acronis just announced a signiýcant new release of 
their top rated backup utility, Acronis True Image 
Home 2009. It is hard to understand how they could 
possibly improve on this excellent product, but they 
did it with dozens of important new features. The 
product may be ordered now on our secure web site 
at www.ugr.com/TrueImage.html for only $29 (as a 
download) or $29 plus shipping (on a CD).
Here are a few of the new features included:

New User Interface ¶ – Acronis completely 
redesigned an already superior user interface. 
It is inspired by Windows Vista and adds 
usability enhancements to make Acronis True 
Image Home even easier to use.
One-click Protection¶ . – Start up Acronis True 
Image Home after installation and the program 
will automatically take stock of your computer 
storage devices. If you have enough free space 
on one of hard drives or in the Acronis Secure 
Zone, it will offer to protect your system right 
away by backing up your system volume and 
Master Boot Record to the storage location of 
your choice. In addition, Acronis True Image 
Home can refresh the backups regularly. Just 
click Protect and your system will be safe 
from a disaster.
Archive to the popular ¶ zip format – Now 
you can specify ýle-level backup archives as 
zip ýles, one of the most popular archiving 
formats, in addition to Acronis’ space-saving 
tib ýles and þat ýle archives. You can extract 
zip ýles from backups created by Acronis 
True Image Home without ýring up the Home 

http://office.microsoft.com/search/redir.aspx?AssetID=HA010548461033&CTT=5&Origin=HA012110041033
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product itself.
Encryption of archive data¶ . Protect sensitive 
data from prying eyes.
More archive location options ¶ – Save full, 
incremental and differential backups of a data 
entity (for example, a partition, disk, E-mail) 
almost anywhere you like. Previously, all 
backups belonging to the same data entity 
could be stored only in the same place. 
Now you can choose a network share, CD/
DVD, Blu-ray, USB stick, FTP-server, or 
any local internal or external hard drive. 
Furthermore, you can now give meaningful 
names like “SystemDiskbeforeRepartitioning” 
to incremental and differential backups to 
simplify your searches.
Make reserve copies of your backups ¶ – Save 
them on the ýle system, a network drive, or a 
USB stick. Copies can be speciýed as regular 
(þat) ýles, a zip compressed ýle, or a tib ýle.
Automatic backup to a removable drive ¶ 
– If you have chosen a removable drive for 
your backups, but it is not attached when a 
scheduled backup time is set to occur, Acronis 
will automatically start the backup  to that 
device as soon as you plug it in. To prevent 
unauthorized persons from backing up the data 
to their own devices, the software requires the 
removable drive to be the same one used for all 
previous backups.
Automatic computer shutdown after backup ¶ 
or restoration ýnishes ï Launch a backup at 
night and walk away without bothering about 
turning off the computer – the program will do 
it for you.
Consolidate backup ýles ¶ ï You can deýne 
rules for consolidating your archives to reduce 
storage space. Merge an older full backup with 
several incremental backups to quickly create a 
new full backup; subsequent backups are based 
on the newly-created full backup.
Automatic consolidation ¶ – Set limits on 
the size of backup archives, the maximum 
number of backups you want to keep, and the 
maximum amount of time archives are to be 
stored. Whenever any of the limits you preset 
is reached, Acronis will automatically combine 
the ýrst full backup with the oldest incremental 
into one full backup dated to that incremental’s 
backup date. Archive integrity is unaffected. 

This feature can be applied to all archives 
Acronis manages except those stored on CD/
DVDs.
Use Google Desktop and Windows Search ¶ 
to search for ýles – Use either search engine 
to ýnd ýles through multiple archives. Type 
in a name or part of the name to ýnd and 
restore individual ýles easily and quickly. File 
contents can be indexed as well.
Try & Decide enhanced¶  - create a temporary, 
safe place on your hard disk where you can 
perform changes to your system that otherwise 
might not be advisable, such as installing 
new software, downloading ýles from the 
Internet, or opening e-mail attachments. If 
the operations are successful, you can apply 
those changes to the real system or discard the 
changes as you wish. New with Home 2009: 
the temporary space you create is maintained 
across system shutdowns and restarts. 

Acronis True Image Home 2009 is available from 
us for only $29 (as a download) or $29 plus shipping 
(on a CD). This is less than the upgrade price through 
Acronis and you get a full new license of the product 
and not an upgrade license. If you order the product 
on a CD, you also get our Perfect Backup Approach 
tutorial to help you understand the best way to do 
backups. There is also a step by step starter’s guide 
for installing and using the product for the ýrst few 
times. The full Acronis manual is also on the CD for 
your use. In addition, I try to help my customers when 
they have questions about True Image. You also have 
the normal technical support through Acronis to assist 
you. You can order your copy of Acronis True Image 
Home 2009 from us at www.ugr.com/TrueImage.html. 
Make sure you use the order code of UGTIH2009 
when placing your order.
If you are a current user of Acronis True Image, then 
you will want to get this new release and put all of the 
new features to work for you. If you have not started 
a backup plan for your computer, then this is the best 
product to accomplish this important task on your 
computer. In either case, place your order today so that 
you can enjoy this new product soon. If you have any 
questions about this article or Acronis True Image 
Home 2009, please send them to support@ugr.com. I 
look forward to helping you if I can.  
Gene Barlow
User Group Relations    PO Box 911600         
St George, UT 84791-1600   



PowerDirector 7  Ultra
By Terry Currier
winnersug@aol.com 

I’ve used several video editing programs over the 
years, but I still like using CyberLinkôs PowerDirector. 
Yes, there are more powerful programs that can do 
more, but I feel that the PowerDirector’s interface is 
just easier to work with, and its faster. If I have not 
used it for a long period of time I can still ýgure things 
out without having to bring up the help.
They have a new Vista like interface with 
PowerDirector 7. I like the new dark background, 
it’s easier on the eyes than the previous bright white. 
One of the more interesting things CyberLink did 
was create a website (http://directorzone.cyberlink.
com/) where users can share customized DVD menus, 
templates, frames, static and motion objects. There 
are hundreds for people to choose from. You can also 
search for and import media into your media library 

from Flickr or Freesound directly. It can work with 
video in either 16:9 or 4:3 aspect ratio.
PowerDirector 7 will allow you to import video from 
an HDD camcorder. The edited ýle can be burned to 
a disc or back to a hard disk drive camcorder. If you 
have the Ultra version you can import AVCHD format. 
I had no problem with taking in my Canon HF100 raw 
AVCHD and working directly on it. If you have a Blu-
ray drive ultra will also work with it. 
The picture-in-picture (PiP) feature is something you 
may not think to use, but once you do you will realize 
how much fun it can be. I’m starting to import old 
VHS tapes of my kids. It was interesting to have the 
high school band practicing their marching in the main 
screen and have a PiP of the march in competition. 
With the new PowerDirector 7 you can have up to 
six PiP. You can modify the size of the PiP, degree 
of transparency of the overlapping clip, as well as its 
position, motion and other properties using the PiP 
Designer. So for my grandson’s birthday party I can 

http://directorzone.cyberlink.com/
http://directorzone.cyberlink.com/


put in the video I took and on the corners have the 200 
still pictures showing in four PiP (he’s really cute.)
The Slideshow Designer has been enhanced with more 
styles to choose from. They say you can synchronize 
photos with the beat of the music and full creative 
control over the design in slideshows. I did not do that, 

but I was really impressed with 
the Slideshow creation. Easy to 
do, add music to the background, 
pan and zoom in Magic Motion, or 
add a style. It will help you create 
soundtracks that ýt perfectly within 
the length of a video clip or photo 
slideshow.  
PhotoNow will let you edit images 
(stills.) You can resize, crop, rotate, 
remove red eye, adjust color, 
brightness and more. They show 
you the original and new image 
side by side so you can decide how 
it compares.
Magic Cut helps you ýt a 
video clip to a speciýc time 
by automatically cutting out 
unnecessary portions and keeping 
only the best moments. The Magic 
Cut feature uses video technology 

to locate and keep the most interesting moments, while 
discarding sections of lesser importance. Great for the 
times when you have to get that 70 minutes of video 
down to 60. I did try it and thought it worked pretty 
good. You still want to check to make sure everything 

you need is in it.
In the Title Designer you can 
move the title to any part of the 
screen, change font, change the 
color, blur it, make it transparent 
(percentage), or change the 
gradient direction. As I said you 
can download many different 
DVD menus, or it is not that hard 
to create your own. One of my 
favorite things is to created a 
short video of up to 90 seconds 
and have it be the background for 
the DVD menu. When burning to 
a DVD in the past version they 
had a feature called Smart Fit 
which supposedly it helped to 
make your video ýt onto a DVD. 
Most of the time it would not 
work for me. Well now in 7 they 
ýxed it.
The Voice-Over Recording 
Room contains controls for 
recording a narration from a 



microphone while watching the video clip the voice-
over is destined to accompany. You can control the 
position and volume of the recording.
Magic Fix will help smooth  shaky video and clariýes 
blurry footage (don’t expect miracles on a bad video.) 
With the previous version using Magic Clean users 
could only apply one improvement method at a time 
- Lighting and Color Adjustment, White Balance and 
Backlight Compensation. With 7 you can apply all at 
the same time.
Is it perfect – well no video editing software is. 
When going to burn a DVD the program default is 
to add background music that goes with the different 
templates. Excuse me, if I wanted it I would put it in. 
Also the template has the title put in as “My Videos” 
for each page you have. More chapters means you will 
have more buttons and therefore more pages. You can 
edit and put in whatever you want. If I put in Soccer 
1993 on the ýrst page I feel is should put that same 
title on all the pages. Instead I have to edit each page 
(and remove the background music from each) to 
change the title.
Besides burning the video to a DVD you can save the 
video you worked on to a good variety of choices. 
These include AVI, MPEG-1, 2 and 4, with full control 
over codec settings. Streaming options of WMV, 
RealVideo and QuickTime. If you want you can write 
your videos back to DV or HDV tape. The Production 
Wizard will link directly into your YouTube account, 
encoding and uploading straight to the Web.
PowerDirector Ultra is $119.95 while the Deluxe 
version is $69.95. if you do not have a camcorder that 
outputs to AVCHD, or Blu-ray than you only need the 
Deluxe. You can download a 30 day trial version from 
the CyberlLink website or Download.com. 
www.cyberlink.com   

Understanding Your Computer’s 
BIOS
by Brian K. Lewis, Ph.D., a Member of the Sarasota 
Personal Computer Users Group, Inc., Florida
www.spcug.org 
bwsail(at)yahoo.com

Obtained from APCUG with the author’s permission 
for publication by APCUG member groups.

The computer’s basic input/output system (BIOS) is 
really a major key to its proper operation.

The BIOS differs from one computer to another 
depending on the make of the motherboard and the 
make of the computer itself. So let’s look at what it 
does and why it is so important for the operation of 
your computer.

When you wake up your computer by turning on 
the power, the ýrst component to be activated is the 
computer processor. The CPU is preprogramed to look 
for a location in the RAM memory, usually near the 
end of system memory. This location contains a jump 
instruction to the location in memory of the BIOS 
program. On activation the BIOS starts executing 
a series of diagnostic instructions to verify that the 
computer is functioning properly. One of the ýrst tests 
is the power-on self test (POST). If there are any fatal 
errors the computer will shut down and not proceed 
further. Some computers have a series of “beep” codes 
that can help a technician in determining the cause of 
the failure.

On some computers one of the ýrst indications that the 
boot process is proceeding normally is the graphics 
card display on the video screen. This is because the 
BIOS has found and loaded the video BIOS. Then 
you will see either a manufacturer’s splash screen or 
the sequence of messages from the BIOS. The BIOS 
also looks for any other connected devices, such as 
SCSI or SATA drives, that have a BIOS Read only 
Memory (ROM) and those instructions will be loaded 
into memory. If the manufacturer’s splash screen isn’t 
hiding the start-up info, you will see the memory 
count, the þoppy, hard drive and CD/DVD drive 
identiýcation lines appearing on the screen.

The BIOS carries out a system inventory that 
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includes determining the memory timing information, 
connection of the keyboard, hard drive parameters, 
plug & play settings, etc. Further it loads the interrupt 
handlers, initializes the registers and resets the 
power management. The BIOS also displays a text-
based summary screen. This summary includes the 
CPU and its clock speed, the drives that have been 
identiýed, their size and type, system memory size 
and conýguration, video, com ports and parallel ports. 
Finally the BIOS looks for a boot drive.

Most modern BIOSes can boot from a wide array of 
devices, not just hard drives. They can boot from CD/
DVD, þash drives, or external drives. In every case 
the BIOS uses the boot sequence information that is 
stored in the CMOS ROM. This is information that 
can be changed by the user. The term CMOS stands 
for Complementary Metal Oxide Semiconductor. Now 
you see why the name is abbreviated. Once the BIOS 
identiýes the boot drive it searches for the master boot 
record and starts the operating system boot process on 
the drive. At that point control of the boot process is 
taken over by the operating system. Many functions 
relating to device drivers and plug & play devices 
handled by the BIOS are now handled directly by 
Windows.

All of the processes carried out by the BIOS are 
required to allow the hardware to interface with 
the operating system. Since the basic hardware in a 
computer can vary widely depending on the make 
and model, there must be a common interface for it 
to communicate with the operating system (OS). The 
OS cannot incorporate all the necessary low level 
routines for all the possible combinations of computer 
hardware. The BIOS provides this common interface.

The BIOS programming is usually contained in a chip 
on the motherboard referred to as an EEPROM chip. 
This is a programmable chip that can be altered by 
using software from the motherboard manufacturer. 
However, anytime you try to change the programming 
in this chip you can change it in such a way as to 
prevent your computer from booting. So great care 
should be taken anytime you need to upgrade your 
BIOS. It is always advisable to make a copy of the 
original BIOS on a removable disk so you can restore 
it if necessary. So when should you need to upgrade 
your BIOS? In some cases manufacturers will make 
BIOS upgrades available which will allow you to 

upgrade your CPU with a newer version. Or they 
make a change to allow the BIOS to recognize faster 
system memory or more memory. You must always 
ensure that the BIOS upgrade you plan on installing 
is speciýc for your motherboard. So you need to 
know the manufacturer and the motherboard model. 
Just remember, a mistake may make your computer 
unusable, requiring a major repair such as replacing 
the motherboard. Unless, of course, you made a 
backup of the original BIOS.

The CMOS portion of the BIOS is also very important 
to the proper function of your computer. The settings 
in the CMOS are retained by use of a low-voltage 
battery on the motherboard. In some few modern 
motherboards you can no longer ýnd the battery. 
That’s because it is integrated into another chip and is 
non-replaceable. Although the battery may have a long 
life span (more than ýve years), some computers are 
still going strong after ten years. Some motherboards 
may use nonvolatile RAM that doesn’t require a 
battery to keep the information safe. In this case the 
battery, if one is present, is used only for the real-time 
clock. So when the battery fails, the computer can still 
boot.

In order to change any of the CMOS settings you have 
to use a key stoke, or series of key strokes, during the 
early part of the boot-up process. The most common 
keystroke is that of the AMI BIOS that uses just the 
DEL key to access the setup program. However, some 
manufacturers use other speciýc keystrokes and may 
even vary the combination from one model to another. 
So it is advisable that you check your owner’s manual 
for speciýc instructions on how to access the setup 
program in your computer. This setup may be called 
the BIOS setup, the CMOS setup or some combination 
of these terms.

The setup program allows you to change some 
parameters related to the operation of your computer. 
Generally you can set the system time and date in 
the CMOS. As mentioned earlier, you can change 
the boot sequence in the CMOS to select the order in 
which the BIOS will look for a bootable drive. The 
CMOS setup allows you to specify how fast your 
computer reads from memory, whether or not your 
CPU’s cache is enabled or disabled and how fast your 
PCI bus communicates with its adapter cards. In the 
advanced settings, you can modify other parameters 



such as power management, USB settings, and enable 
or disable I/O ports. You may also be able to set 
the computer to turn on in response to an incoming 
call on a modem or a request via a local network. In 
some motherboards the CMOS settings allow you to 
“overclock” your system. This means that you can 
set your CPU and/or system memory to operate at a 
frequency higher than the standard manufacturers’ 
values. Unless used with great care, changing these 
values can destabilize the computer operation. The 
settings in the CMOS will vary depending on the 
computer manufacturer and the make of the BIOS. 
Some manufacturers make their own BIOS chips 
while others purchase them from companies such as 
AMI, Phoenix or WinBond. Reading your user manual 
or motherboard manual will give you a better idea of 
just what is included in your setup program.

The setup program uses a “CMOS checksum” as an 
error-detecting code. Each time you change the BIOS 
settings, the checksum is generated by adding all 
the bytes in the CMOS memory and then storing the 
lowest byte of the sum. Then, each time the system 
is booted, the system recomputes the checksum and 
compares it with the stored value. If they are different, 
then the system knows that the CMOS has been 
corrupted somehow and will warn you with an error, 
typically something like “CMOS Checksum Error”. 
Then you need to enter the setup program and check 
the settings. Usually, once you save the settings and 
exit setup, the computer will boot normally.

Most of the preceding information applies when 
you ýrst start the computer after it has been off for a 
time. This is called a “cold boot”. If you restart your 
computer from Windows using the “restart” selection, 
or the ñthree-ýnger saluteò (CTRL-ALT-Del), or 
the “reset” button, then this is a “warm boot”. Then 
most of the POST is omitted and the BIOS reloads 
interrupts, device drivers, checks the CMOS and loads 
the peripheral BIOSes. Then the memory, drives and 
summary are displayed on the video screen.

As I hope you now realize, the BIOS and its associated 
CMOS are essential for the operation of your 
computer. Always be cautious in making changes in 
the setup or in updating your BIOS. That way you can 
ensure continued operation of your system.

There is another thing I should mention. Use of the 

BIOS originated with the IBM AT some twenty-ýve 
years ago. As computer technology has changed 
radically in this time span, there is a move afoot to 
replace the BIOS with what is referred to as “UEFI” 
or Uniýed Extensible Firmware Interface. The 
speciýcations for this interface were ýrst published 
in October 2006 and revised in January 2007. The 
statement of purpose from the UEFI organization is as 
follows: ñThe Uniýed Extensible Firmware Interface 
(UEFI) speciýcation deýnes a new model for the 
interface between operating systems and platform 
ýrmware. The interface consists of data tables that 
contain platform-related information, plus boot and 
runtime service calls that are available to the operating 
system and its loader. Together, these provide a 
standard environment for booting an operating system 
and running pre-boot applications.”

Currently the companies involved are working on 
producing motherboards using the UEFI ýrmware 
in place of the BIOS. However, there is also some 
consideration that some users may need to have both 
a BIOS and the UEFI ýrmware. Since this process is 
still in þux, keep tuned for future developments.

*Dr. Lewis is a former university & medical school 
professor. He has been working with personal 
computers for more than thirty years. He can be 
reached via e-mail at bwsail@yahoo.com.

This article has been provided to APCUG by the 
author solely for publication by APCUG member 
groups. All other uses require the permission of the 
author (see e-mail address above).
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Funny Signs in Great Britain: (but could be anywhere) 

 1. IN A LAUNDROMAT: Automatic washing 
machines. Please remove all your clothes when the 
light goes out. 

 2. IN A LONDON DEPARTMENT STORE: Bargain 
Basement Upstairs

 3. IN AN OFFICE: Would the person who took the 
step ladder yesterday kindly bring it back or further 
steps will be taken.

 



Data Transfer Rates 
By Michael Hanst, Director, Lake-Sumter Computer 
Society, Florida
www.lscs.us 
mtjhanst(at)netscape.net
 
Obtained from APCUG with the author’s permission 
for publication by APCUG member groups.
 
During one of the meetings of the Lake-Sumter 
Computer Society, there was a discussion of Internet, 
Ethernet, and Wi-Fi transfer speeds. I decided to 
go look for speciýcations and found references that 
looked at each area, but found none that put it all in 
one chart. Plus, the references are often confusing 
because they use different criteria for the transfer 
rates. So, the idea for this article was born.

http://www.scotsnewsletter.com/best_of/dtrct.htm

Disclaimer: The “expected” or “average” values are 
not meant to be absolute numbers, but rather to place 
items in their relative position of real world data trans-
fer rates, also known as bandwidth.

Notes: (Reference)
Å	 8 bits = 1 byte
Å	 bps = bits per second
Å	 kbps = 1,000 bits per second (1)
Å	 Mbps = megabits per second
Å	 MBps = megabytes per second [(1) Approxi-
mately equal to Mbps divided by 8. The binary, K = 
1,024, is ig-nored for this article since all estimated 
values are affected equally.] 

(1) Wikipedia
http://en.wikipedia.org/wiki/Kbps
(2) Scot’s Newsletter
http://www.scotsnewsletter.com/best_of/dtrct.htm 


